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Overview 

As projects become larger and more complex, the project critical path becomes more dynamic and the 
schedule becomes more challenging to analyze. An analysis tool that provides the project team the 
ability to focus on production driven major operations that are expected to drive the schedule is vital to 
the successful on time completion of the project. 

The VDOT Commodity Progress Report (Form C‐13CPR) is a commodity tracking tool that is required by 
specifications for Category III and Design‐Build projects to track performance on the major operations 
that are expected to drive the project. It allows the project team to identify what major operations are 
critical and require extra attention. Moreover, it allows the project team to analyze and track periodic 
performance and trends to identify early, what major operations are at risk of falling behind and when 
further evaluations are necessary for corrective actions. 

As part of its Progress Schedule submissions for Category III and Design‐Build projects, the contractor is 
required to provide a Commodity Progress Report showing the budgeted units‐loading and anticipated 
monthly production output for each major operation that is expected to drive the schedule. The 
Commodity Progress Report shall include: 

1. A Commodity‐loading Report (CLR) generated from the Primavera P6 software, showing a 
breakdown of the bid item quantity assignments for each activity associated with a Commodity 
(Major Operation). The CLR is a Primavera P6 report that shows at the activity level, planned and 
actual durations and quantities; and production rates to provide the ability to determine the 
reasonableness of the schedule; as well as track performance at the activity level. This 
information can be reviewed to determine if it aligns with the production rates information 
provided in the narrative and if they are reasonable by industry standards. 

2. A Commodity Progress Report (CPR) prepared using the VDOT Form C‐13CPR and monthly units 
data generated from the Baseline Schedule showing for each estimate date and for each 
commodity. The Form C‐13CPR is a MS Excel spreadsheet report that shows for each Commodity 
(Major Operation) the monthly progress S‐curve based on the project monthly planned and 
actual progress data generated from the Primavera P6 software. 
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1. Downloading the Commodity Progress Report Files – The following are guidelines for downloading 
a copy of the Form C‐13CPR and the required Primavera P6 “erp” files: 

1. Use the following link to access the VDOT Construction Scheduling Webpage: 

https://www.virginiadot.org/business/const/ConstrSchResSpecs.asp 

2. Download a copy of the Form C‐13CPR (MS Excel) and the required Primavera P6 Commodity 
Loading Report (CLR) and Commodity Progress Report (CPR) “erp” files. (Note: For traditional 
Design‐Bid‐Build projects, download the “Estimate Dates” report. For Design‐Build projects, 
download the “Calendar Months” report). 

3. After downloading the files, you may move the files from your Downloads folder (or other 
location in which the files were downloaded) to a preferred file location using the MS Excel 
Cut/Paste function. 
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2. Importing the Primavera P6 Reports – The Primavera P6 CLR and CPR “erp” reports can be imported 
to your Primavera P6 database for use in preparing the CLR and Form C‐13CPR. The following are 
guidelines for importing the Primavera P6 “erp” reports: 

1. In the Reports window in Primavera P6, select a Report Group under which the new report will 
be added, then right‐click, and then click on Import. 

2. Locate the Contractor’s Commodity Loading Report.erp file, select, and then click on Open. 
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3. Click on the OK button after the report has been imported successfully. 

4. Repeat Steps 1 through 3 to import the Contractor’s Monthly Commodity Progress Report (CPR). 
The Primavera P6 CPR report will be used to generate/export the monthly units (quantities) data 
needed to complete the Form C‐13CPR. 
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3. Preparing a Commodity Loading Report (CLR) – The Commodity Loading Report (CLR) is required to 
show units (quantities) data for each activity associated with a Commodity (designated production 
based major operations that are expected to drive the schedule). The following are guidelines for 
preparing a Primavera P6 Commodity Loading Report (CLR): 

1. In the Reports window in Primavera P6, select the Commodity Loading Report (CLR), then using 
the right click and Copy/Save function, create a copy of the report for project‐specific use. 

2. Select the copy of the Commodity Loading Report (CLR), then modify the report for project‐
specific use as follows: 

1. Click on the Tools menu, then select Report Wizard. 
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2. In the Report Wizard Create or Modify Report window, select Modify Wizard Report, then 
click on Next. 

3. In the Configure Selected Subject Areas box, deselect Activity Resource Assignments Past 
Period Actuals sub‐project, then click on Next. 
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4. In the Configure Selected Subject Areas box, click on the Columns button. 

5. Under the Resource Codes category, select the pre‐defined project specific commodity 
resource code created for the project (e.g. C00012345B01_Commodity). Then click on OK. 

6. In the Configure Selected Subject Areas box, click on the Group & Sort button. 

VDOT Commodity Progress Report (Form C‐13CPR) User Guide (2023) Page 8 



       
   

 

                      
 

                            
                   

 

 
 
 

                        
 

 
 
 

                              
                       

 

 

Virginia Department of Transportation 
Construction Division 

7. In the Group and Sort box, select the pre‐defined project specific commodity resource code 
created for the project (e.g. C00012345B01_Commodity). Then click on OK. 

8. In the Configure Selected Subject Areas box, click on the Filter button. 

9. In the Filter box, select the project specific commodity resource code created for the project 
(e.g. C00012345B01_Commodity). Define the parameters as shown below; then click on OK. 
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10. In the Configure Selected Subject Areas box, click on Next. 

11. In the Report Title box, rename the report to make it project‐specific, click on Next. 
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12. In the Report Generated box, click on Next. 

13. Click on Save Report; then click on Finish to save the report and close Report Wizard. 
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3. In the Reports window, select the saved project‐specific Contractor’s Monthly Commodity 
Progress Report; then right‐click, then click on Run, and then Report. 

4. Select Print Preview and click on OK. 
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5. A Commodity Loading Report (CLR) is generated. Click on the Page Setup/Print Setup/Print 
icons, as needed to modify the Company Name, print settings, or to print the report. 
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4. Modifying the MS Excel Software Security Settings – The Form C‐13CPR uses built‐in MS Excel 
formulas and macros. Your software security software settings must be modified to notify you to 
enable macros when using the Form C‐13CPR, if not enabled based on user settings. The following 
are guidelines for modifying the MS Excel software security settings: 

1. Open MS Excel and click on File at the top left hand corner to display the File menu. 

2. In the File menu, select Options. In the Excel Options window, select Trust Center; and then click 
on the Trust Center Settings button. 
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3. In the Trust Center window, select Macro Settings, and then you may select Enable all macros, 
or at a minimum, select Disable all macros with notifications. 

4. In the Trust Center window, select Message Bar, and then select Show the Message Bar in all 
applications when active content, such as ActiveX controls and macros, has been blocked. 

5. Click OK a couple of times to accept the settings and close the Trust Center and Excel Options 
dialogue boxes. 
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5. Preparing the Form C‐13CPR for Initial Use – The following are guidelines for setting‐up the Form C‐
13CPR for initial use: 

1. Obtain a copy of the Form C‐13CPR file, then save in the Excel Macro‐Enabled Workbook (.xlsm) 
file format; and rename for a specific project using a naming convention that identifies the 
Contract ID, submission version, and type of submission (e.g. C00012345C01_BS_Baseline 
Schedule C‐13CPR.xlsm). 

2. Open the file. If the PROTECTED VIEW message appears on top of the worksheet, click on the 
Enable Editing button. 

3. If the macros SECURITY WARNING message appears on top of the worksheet, click on the Enable 
Content button to enable the built‐in macros. 

4. Click on the Controls Chart Data tab to open the Controls Chart Data worksheet, and then enter 
the Contractor’s name (Cell A1); and type of submission and sequence number, and data date 
(Cell A3). Then enter the Contract ID and other required project information on the top left 
corner of the form (Cells C5 to C10). 
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5. In the Controls Chart Data worksheet, also enter the required Contract NTP Date and other 
required time related information on the top right corner of the form (Cells X5 to X9). 
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6. Preparing a Baseline Commodity Progress Report (CPR) – For Category III and Design‐Build projects, 
a Baseline Commodity Progress Report (CPR) is required and shall be prepared using the VDOT Form 
C‐13CPR. The Form C‐13CPR shall show the Contractor’s anticipated progress each month for each 
selected major operation, as agreed upon by the Engineer and the Contractor. The Form C‐13CPR 
shall be prepared using time‐distributed monthly units (quantities) data generated from the cost‐
loaded Baseline Progress Schedule, as of the Contractor’s progress estimate date. The following are 
guidelines for preparing a Baseline Commodity Progress Report (Form C‐13CPR): 

1. In the Primavera P6 scheduling software, click on the Edit menu, then click on User Preferences; 
and then select Resource Analysis. Specify the Time‐Distributed Data as shown below. 

2. In the Reports window in Primavera P6, select the Contractor’s Monthly Commodity Progress 
Report (Form C‐13CPR), then using the right click and Copy/Save function, create a copy of the 
report for project‐specific use. 
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3. Select the copy of the Contractor’s Monthly Commodity Progress Report (Form C‐13CPR), then 
modify the report for project‐specific use as follows: 

1. Click on the Tools menu, then select Report Wizard. 

2. In the Report Wizard Create or Modify Report window, select Modify Wizard Report, then 
click on Next. 
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3. In the Configure Selected Subject Areas box, click on the Columns button. 

4. Under the Resource Codes category, select the pre‐defined project specific commodity 
resource code created for the project (e.g. C00012345B01_Commodity). Then click on OK. 

5. In the Configure Selected Subject Areas box, click on the Group & Sort button. 
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6. In the Group and Sort box, select the pre‐defined project specific commodity resource code 
created for the project (e.g. C00012345B01_Commodity). Then click on OK. 

7. In the Configure Selected Subject Areas box, click on the Filter button. 

8. In the Filter box, select the project specific commodity resource code created for the project 
(e.g. C00012345B01_Commodity). Define the parameters as shown below; then click on OK. 
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9. In the Configure Selected Subject Areas box, click on Next. 

10. In the Date Options box, click on Next. 

11. In the Report Title box, rename the report to make it project‐specific, click on Next. 
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12. In the Report Generated box, click on Next. 

13. Click on Save Report; then click on Finish to save the report and close Report Wizard. 
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4. In the Reports window in Primavera P6, select the saved project‐specific Contractor’s Monthly 
Commodity Progress Report; then right‐click, then click on Run, and then Report. 

5. In Run Report dialogue box, select Delimited Text File and verify Field Delimiter and Text 
Qualifier types; and then enter the Output file location and name. Mark the View file when done 
checkbox to open the file when created; and then click on the OK button. 

6. Upon clicking on the OK button a “csv” file will be created, saved, and opened in MS Excel. 
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7. In the Form C‐13CPR “csv” worksheet generated from Primavera P6, click on Cell A3, then drag 
down to Cell A32 (Column A, Rows 3 thru 32) and then across to the Total column to select the 
values for each pay period and the Total column; and then right‐click and click on Copy to copy 
the selected data. 

8. In the Form C‐13CPR Commodity Data Input worksheet, click on Cell A3 in the Baseline Monthly 
Commodity Data section, then right‐click and then click on Paste Values to paste the monthly 
values copied from the C‐13CPR “csv” worksheet. 
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9. For the Baseline and any subsequent Revised Baseline submissions only, click on Cell A35; then 
right‐click and click on Paste Values to paste the baseline data onto the Current Update Schedule 
Monthly Commodity Data section. 

10. Review to make sure that the monthly values for each estimate period and Total column align 
with the “csv” worksheet, adjust as necessary. (Note: The number of estimated periods shown 
on the Form C‐13CPR may be more or less than the number of estimate periods in the monthly 
cost data “csv” worksheet, if the calculated finish date of the project is different from the 
Contract Completion Date or Current Projected Date entered on the Form C‐13CPR). Adjust as 
necessary using the MS Excel Copy/Paste function. 

11. Click on the Progress Charts tab at the bottom to display the Charts worksheet. Click on the 
Update Progress Charts button to update the charts when the data is updated. 
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12. In the Controls Charts Data worksheet, you may click on the Show Progress Data button to 
display the Progress Data worksheet. 

13. The Progress Data worksheet displays the monthly production data (quantities) used in 
calculating the progress percentages. 
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7. Preparing an Update Commodity Progress Report (CPR) – For Category III and Design‐Build 
projects, an Update Commodity Progress Report (CPR) is required and shall be prepared using the 
VDOT Form C‐13CPR. The Form C‐13CPR shall show the Contractor’s actual/projected progress each 
month for each selected major operation, as agreed upon by the Engineer and the Contractor. The 
Form C‐13CPR shall be prepared using time‐distributed monthly units (quantities) data generated 
from the cost‐loaded Update Progress Schedule, as of the Contractor’s progress estimate date. The 
following are guidelines for preparing an Update Commodity Progress Report (Form C‐13CPR): 

1. Obtain the previously accepted Form C‐13CPR, then save a copy and rename the file to indicate 
the submission type, number, and current data date of the update (e.g. C00012345C01_U01_C‐
13CPR_4‐4‐22.xls). 

2. In the Controls Chart Data worksheet and on the top right corner of the form (Cells X5 to X9), 
update the current Contract Completion Date, Projected Completion, and Current Progress 
Estimate Date (Data Date), as needed. 

3. Open the current Update Schedule in Primavera P6. In the Reports window in Primavera P6, 
select the previously saved project‐specific Contractor’s Monthly Commodity Progress Report; 
then right‐click, then click on Run, and then Report. 
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4. In Run Report dialogue box, select Delimited Text File and verify Field Delimiter and Text 
Qualifier types; and then enter the Output file location and name. Mark the View file when done 
checkbox to open the file when created; and then click on the OK button. 

5. Upon clicking on the OK button a “csv” file will be created, saved, and opened in MS Excel. 

6. In the Form C‐13CPR “csv” worksheet generated from Primavera P6, click on Cell A3, then drag 
down to Cell A32 (Column A, Rows 3 thru 32) and then across to the Total column to select the 
values for each pay period and the Total column; and then right‐click and click on Copy to copy 
the selected data. 
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7. In the Form C‐13CPR Commodity Data Input worksheet, click on Cell A35; then right‐click and 
click on Paste Values to paste the current update data onto the Current Update Schedule 
Monthly Commodity Data section. 

8. Review to make sure that the monthly values for each estimate period and Total column align 
with the “csv” worksheet, adjust as necessary. (Note: The number of estimated periods shown 
on the Form C‐13CPR may be more or less than the number of estimate periods in the monthly 
cost data “csv” worksheet, if the calculated finish date of the project is different from the 
Contract Completion Date or Current Projected Date entered on the Form C‐13CPR). Adjust as 
necessary using the MS Excel Copy/Paste function. 

9. Click on the Progress Charts tab at the bottom to display the Charts worksheet. Click on the 
Update Progress Charts button to update the charts when the data is updated. 
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10. In the Controls Charts Data worksheet, you may click on the Show Progress Data button to 
display the Progress Data worksheet. 

11. The Progress Data worksheet displays the monthly production data (quantities) used in 
calculating the progress percentages. 
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For assistance or questions, please contact Frank Gbinije: 

frank.gbinije@vdot.virginia.gov 
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